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অ঩নায  আ−ফুক ফা pdf রযডারযয Menu Bar এয View  ঄঩঱নরি তত রিক করয Auto /Automatically Scroll  ঄঩঱নরি  র঳ররক্ট 
করুন (঄থফা ঳যা঳রয  তমরত   Ctrl + Shift + H )। এফায ↑ up Arrow ফা  ↓ down Arrow তত  রিক করয অ঩নায ঩ড়ায ঳ুরফধা 
঄নু঳ারয স্ক্রর স্পীড রিক করয রনন।  

Microsoft Excel ঴রে একরি Spreadsheet তরাগ্রাভ। আ঴া Microsoft Office এয একরি ঄ং঱। এরি 
একরি Worksheet Analysis তরাগ্রাভ঑। ভূরতঃ এরেররয ঳া঴ারমে ডািা এরি এফং ঄োনারাআর঳঳ উবয় 
঳ুরফধা ঩া঑য়া মায়। অভারদয ঩যীক্ষায Marksheet এয ঳ারথ অভযা ঳ফাআ ঩রযরচত। Spreadsheet ঴রে 
ভাকক঱ীরিয ভত এক ধযরণয ছক। Microsoft Word খুররর তমভন কা঳কয঳঴ একরি ঳াদা ঩াতা ঩া঑য়া মায় 
এফং কী-তফাডক তথরক ররখরত শুরু কযরর ঳াদা ঩াতায় তরখা শুরু ঴য়। ততভরন Excel খুররর ঳াদা ঩াতায 
঩রযফরতক তিরফররয ভত একরি ছক ঩া঑য়া মায় এফং ররতরি ঘরয করয়করি ঄ক্ষয তরখা মায়। এছাড়া এরি 
ভাকক঱ীরিয ভত করাভ (Column) এফং ঳ারযরত (Row) রফবক্ত থারক। A, B, C, D এবারফ করারভয নাভকযণ 
কযা থারক এফং 1, 2, 3, 4 এবারফ ঳ারযয নাভকযণ কযা থারক।  
এআ ঳ভস্ত ঘরয ঄ফরিত গারণরতক ঳ংখোরক উ঩য, রনচ, ডান ফা ফাভ, তম তকান রদক তথরক তমাগ, রফরয়াগ, গুণ, 
বাগ আতোরদ কযা মায়। ঳াধাযণত তমাগ, রফরয়াগ, গুণ, বাগ আতোরদ঳঴ জরির গারণরতক ঳ভ঳োয ঳ভাধান, ডািায 
উ঩য রবরি করয রফরবন্ন ধযরণয গ্রাপ ততযী, ডািারক ঳াজারনা঳঴ রফরবন্ন ধযরণয ডািা ভোরনজরভন্ট, 
঩রয঳ংখোরনয রফরবন্ন কাজ Excel রদরয় কযা ঴য়। ঄োকাা্ন্টর঳য রফরবন্ন কাজ, তমভন- তরজায, রাব ক্ষরত র঴঳াফ, 
Balance Sheet আতোরদ কাজ঑ Excel রদরয় কযা ঴রয় থারক। এজনে Microsoft Excel তক Accounting 
Package ProgramI ফরা ঴য়।  
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রনরচয উদা঴যণ রক্ষে করুন। Excel ফেফ঴ায করয একরি ডািারফজ এফং ঳ংরিষ্ট চািক তদ঑য়া অরছ।  

 

঳঴জবারফ তফাঝারনায জনে একরি ররতষ্ঠারনয PC, Disk এফং CD রফরিয ডািারফজ ততযী কযা ঴রয়রছ। রথরভ 
January, February এফং March এফং ভার঳য ঩রযভান অরাদাবারফ রনণকয় করয। ঩রয Total রনণকয় কযা ঴রয়রছ। 
এখারন Total RowwU পভূকরায (=B2+B3+B4) ভাধেরভ একরি ত঳র এ রনণকয় করয ঩রয Copy কযা ঴রয়রছ। এ রফলরয় 
রনধকারযত ঄ংর঱ রফস্তারযত অররাচনা কযা ঴রয়রছ। এরক্ষরে একরি তছাি ডািারফজ রনরয় কাজ কযা ঴রয়রছ। রকন্তু করয়ক 
঴াজায ফা রক্ষ ডািায mgš̂‡q গরিত ডািারফরজয তক্ষরে কল্পনা করুন এক রভরনরিয ভরধেআ করয়ক রক্ষ ডািায তমাগপর 
একভাে Excel রদরয়আ রনণকয় কযা ঳ম্ভফ। এছাড়া঑ এআ ডািারফরজয উ঩য রবরি করয একরি চািক ফা গ্রাপ঑ ঳ংমুক্ত কযা 
঴রয়রছ Excel এয ভাধেরভ।  
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঳াধাযণত তডস্কির঩য Start তভনু তথরক তরাগ্রাভ চারু কযা ঴য়। এছাড়া঑ ঄রনক ঳ভয় রফরবন্ন ঳ভয় রফরবন্ন 
তরাগ্রারভয জনে তডস্কির঩ ঱িককািক ততযী করয যাখা ঴য়। এখান তথরক঑ তরাগ্রাভ শুরু কযা মায়। এছাড়া ঄রপ঳ 
঱িককািক ফায ফরর একরি ফায এ ঄ফরিত Excel অআকরন রিক করয঑ Excel শুরু কযা মায়। অভযা এআ 
ফআরত রনরদকষ্ট একরি ঩দ্ধরত ফেফ঴ায কযরফা। ঳ারথ ঳ারথ রফকল্প ঩দ্ধরতগুররা঑ ঩া঱া঩ার঱ তদ঑য়া থাকরফ। নতুন 
র঱ক্ষাথকীরদয জনে একারধক ঩দ্ধরতয ফদরর রনরদকষ্ট একরি ঩দ্ধরত ফেফ঴ারযয ঄নুরযাধ কযরফা। তরাগ্রাভরি m¤^‡Ü 
঩মকাপ্ত ধাযণা ঴঑য়ায ঩য ঄নোনে ঩দ্ধরত ফেফ঴ারযয ঄নুরযাধ যআর।  
Excel শুরু কযায জনে রনরচয কভান্ডগুররা Step by step ররয়াগ করুন- 

1) ভাউ঳ ঩রয়ন্টায দ্বাযা Start ফািরনয উ঩য রিক করুন; 
2) তভনু তথরক Programs ফা All Programs এয উ঩য রিক করুন;  
3) Excel রড঳রে চরর অ঳রফ।  
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এভ.এ঳. এরেরর ঢুরক রকছু তরখা িাআ঩ করয পাআররি ঳ংযক্ষন কযরত ঴রর অ঩নারক রনরেয ঩দরক্ষ঩ রনরত 
঴রফ- 

1) File তভনুরত রিক করুন 
2) Save এ রিক করুন; 
3) ঩দকায় ত঳ব এজ ডায়ারগ ফে অ঳রফ- 
4) তম নারভ ঳ংযক্ষন কযরত চান ত঳ নাভ িাআ঩ করুন; (†hgb-DISIT)  
5) Save ফািরন রিক করুন। 
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1) কা঳কয ফতকভারন A1 ত঳রর ঄ফিান কযরছ।  
2) কী-তফাডক তথরক Months িাআ঩ করয Enter তর঳ করুন;  
3) A1 ত঳রর Months তরখা ঴রফ এফং ঩রয়ন্টায (চাযরকাণা ফডকায঳঴ একরি এরযয়া, এরিআ ঩রয়ন্টায ফা 

Excel এয কা঳কয) রনরচয Row তত ঄থকাৎ A2 ত঳র-এ ঄ফিান কযরফ;   
4) এবারফ ফাকীগুররা িাআ঩ কযা মারফ।  

Cell, Column ঑ Row :  
পভূকরা ফারযয রনরচ ঄ফরিত A, B, C, D আতোরদ তরখা j¤^vjw¤^ রাআনগুররা (Vertical) তক Column ফরর 
এফং 1, 2, 3, 4 আতোরদ তরখা অড়াঅরড় রাআনগুরররক Row ফরর এফং ররতরি ঘযরকআ একরি Cell ফরর।  

Title Bar : 

Excel Screen-Gi ঳ফরচরয় উ঩রয ফাভ রদরক Microsoft Excel-Book1 তরখা নীর যরঙয ফাযরিয নাভ 
িাআরির ফায। Microsoft Office এয ঳ফগুররা তরাগ্রারভ এআ ফায থারক। এখারন ঳ফ ি঑য়োযরিয নাভ এফং 
তকান পাআর তখারা থাকরর তায নাভ তরখা থারক।   

িাআরির ফারযয রিক রনরচ এরেররয কভান্ড঳ভূ঴, তভনু অকারয File, Edit, View আতোরদ তরখা ফাযরিয নাভ 
তভনু ফায। File, Edit আতোরদ নাভরক তভনু কভান্ড ফরর। তভনু ফারযয ররতরি অআরিরভ (তমভন- File, Edi, 
View, Format আতোরদ) রিক কযরর একরি করয ড্র঩ ডাউন তভনু অর঳। এখারন ঳াফ তভনু থারক। এআ 
঳াফরভনু তথরক কভান্ড রদরত ঴য়। 
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তভনুফারযয রিক রনরচ অআকন ফা িুর (তছাি তছাি ছরফ) ঳঴ ফাযরিয নাভ স্টান্ডাডক ফায। অভযা তভনু ফারযয 
঳া঴ারমে তম কভান্ডগুরর ফেফ঴ায করয থারক তায ঳ফগুররআ স্টান্ডাডকফারয িুর-এ রিক করয ররয়াগ কযা ঳ম্ভফ।  

স্টান্ডাডক ফারযয রনরচ Arial, 10, B, I, U তরখা ফাযরিয নাভআ পরভকরিং ফায। এআ ফারযয িুরগুররয ঳া঴ারমে 
রফরবন্ন ধযরণয পন্ট, পরন্টয ঳াআজ, Bold, Italic, Underline আতোরদ ঳঴রজ কযা মায়।   

পরভকরিং ফারযয রনরচ ২রি ঄ংর঱ রফবক্ত ফাযরিরক ফরর পভূকরা ফায। পভূকরা ফারযয রথভ ঄ংর঱ কা঳কয তম ত঳রর 
঄ফিান কযরছ ত঳রি তরখা থারক ঄থকাৎ B5, F14 আতোরদ এবারফ তরখা থারক।  

 এআ ঄ংর঱ Cell Address তরখা থাকায কাযরণ এরিরক Name Box ফরর। এআ ঄ংর঱ তকান Cell Address 
রররখ (তমভন- M5, B9 আতোরদ) Enter রদরর ত঳আ ত঳রর কা঳কয চরর মারফ। Name Box এয ঩ার঱ fx তরখায 
঩ার঱ পাাঁকা িারন ঩রয়ন্টায ঄ফরিত ত঳রর তকান পভূকরা ফা ডািা তরখা থাকরর ত঳রি তদখা মারফ।  

  

ডািারফজরি ঄রনক ফড় ঴রর এফং স্ক্রীরন না অিরর উ঩য/রনচ ফা ডান/ফারভয ডািা তদখা মায় না। Excel 
স্ক্রীরনয ডান রদরকয ফাযরিয নাভ Vertical Scroll ফায, এরিয ঳া঴ারমে উ঩য/রনরচয ডািারক স্ক্রর করয তদখা 
মায়। ঄঩য রদরক রনরচয ফাযরিয নাভ Horizontal Scroll ফায, এরিয ঳া঴ারমে ডান/ফারভয ডািা স্ক্রর করয 
তদখা মায়।   

Horizontal Scroll ফারযয রনরচ ঄থকাৎ Excel স্ক্রীরনয ঳ফরচরয় রনরচ Ready তরখা ঳঴ফাযরিয নাভ Status 
ফায। তস্টিা঳ ফারয Ready তরখা থাকরর ফুঝরত ঴রফ কা঳করযয ফতকভান ঄ফিা তরখায উ঩রমাগী ঄ফিায় অরছ।  

Excel-G রফরবন্ন ঳ভয় রফরবন্ন করাভ/তযা ফা Cell এয ডািা ফা পযভোি ফা পভূকরা আতোরদ কর঩, ভুখ কযা ফা 
঳াআজ, কারায আতোরদ ঩রযফতকন করয রফরবন্ন ধযরণয এরডি কযায ররয়াজন ঴রত ঩ারয এজনে রথরভআ 
রফলয়ফস্তুরক Block ফা র঳ররক্ট কযরত ঴রফ। ভাউ঳ ঄থফা কী-তফাডক দুআ ঩দ্ধরতরতআ অরগয ভত Block/Select 
কযা মায়।  
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1) C5 ত঳র র঳ররক্ট করুন; 
2) তভনু তথরক Insert এ রিক করুন ড্র঩-ডাউন তভনু অ঳রর Cells এ রিক করুন; 

Insert ডায়ারগ ফে অ঳রফ। Shift Cells Right এফং Shift Cells Down ঄঩঱ন তদখা মারফ।  

3) Shift Cells Down -এ রিক করুন; 
4) ত঱রল OK করুন।  

 

C5 ত঳ররি পাাঁকা ঴রফ এফং ডািাগুরর এক ত঳র করয রনরচ তনরভ মারফ।  

 

 

 

 

 

 

   

Shift Cell Right ফািন র঳ররক্ট কযরর ডািাগুররা এক ত঳র করয ডারন ঳রয তমত। একারধক Cell র঳ররক্ট 
থাকরর ত঳আ ঳ংখেক ত঳ররয জনে একআ কাজ ঴রতা।  
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পাকা Cell তক Delete কযা : 
5) C5 ত঳র র঳ররক্ট করুন; 
6) তভনু তথরক Edit এ রিক করুন ড্র঩-ডাউন তভনু অ঳রর Delete এ রিক করুন; 

Delete ডায়ারগ ফে অ঳রফ। Shift Cells Left এফং Shift Cells Up ঄঩঱ন তদখা মারফ।  

7) Shift Cells Up -এ রিক করুন; 
8) ত঱রল OK করুন।  

C5 ত঳রর রনরচয ররতেক ত঳ররয ডািা এক ত঳র করয উ঩রয উরি অ঳রফ। একারধক Cell র঳ররক্ট থাকরর ত঳আ 
঳ংখেক ত঳ররয জনে একআ কাজ ঴রতা। 

1) C করারভয তম তকান Cell এ কা঳কয (঩রয়ন্টায) যাখুন ফা ঳মূ্পণক C করাভ র঳ররক্ট করুন;  
2) তভনু তথরক Edit রিক করয; Delete এ রিক করুন।  

Delete ডায়ারগ ফে অ঳রফ-  

3) Entire column এফং Entire row ঄঩঱ন থাকরফ।  
4) Entire column ফািন র঳ররক্ট করুন;  
5) ত঱রল OK করুন।  

পাাঁকা করাভরি ভুরছ মারফ এফং ঳ভস্ত ডািা এক করাভ ফারভ ঳রয অ঳রফ।  
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1) C5 ত঳রর কা঳কয (঩রয়ন্টায) যাখুন ফা ঳মূ্পণক ৫ b¤^i ঳ারয (Row) র঳ররক্ট করুন; 
2) তভনু ফায তথরক Insert>Row কভান্ড রদন। নতুন একরি পাাঁকা ঳ারয অ঳রফ এফং ডািাগুরর এক঳ারয 

রনরচ তনরভ মারফ।  

একারধক ঳ারয ফা ঳ারযয ত঳র র঳ররক্ট থাকরর একারধক নতুন ঳ারয ঩া঑য়া তমত এফং ত঳আ ঄নু঳ারয ডািা ঳রয 
তমত।  

1) 5 b¤̂i ঳ারযয তম তকান ত঳র এ কা঳কয যাখুন ফা ঳মূ্পণক ৫ b¤̂i ঳ারয র঳ররক্ট করুন;  
2) তভনু তথরক Edit>Delete কভান্ড রদন। Delete ডায়ারগ ফে অ঳রফ। Entire column এফং Entire 

row ঄঩঱ন থাকরফ।  
3) Entire row ফািন র঳ররক করয OK করুন।  

পাাঁকা ঳ারযরি ভুরছ মারফ এফং ডািা উ঩রয উরি অ঳রফ। উরেখে ঳ভস্ত করাভ ফা ঳ারয র঳ররক্ট করয কী-তফাডক 
তথরক Delete কী তর঳ কযরর ডািা ভুরছ মারফ; রকন্তু ডািা িানান্তরযত ঴রফ না।  

মরদ঑ Excel -এয ররত Workbook -এ ঳াধাযণত Sheet1, Sheet2 ঑ Sheet3 থারক। এ ঄ফিায় নতুন 
Worksheet দযকায ঴রর অনা মারফ।  

1) পাআররয রনরচয রদক তথরক Sheet3 তত রিক করয র঳ররক্ট করুন; 
2) তভনু তথরক Insert>Sheet (Worksheet) কভান্ড রদন। রক্ষে করুন Sheet4 নারভ নতুন একরি Sheet 

঩া঑য়া মারফ।  
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Worksheet ভুরছ তপরা : 

1) Sheet4 র঳ররক্ট করয তভনু তথরক Edit>Delete Sheet কভান্ড রদন; ঳তককতাভূরক ডায়ারগ ফে অ঳রফ।  
2) Delete ফা OK ফািরন রিক করুন। 

ভূরত গারণরতক ঳ংখোয তক্ষরে ফেফ঴ায কযা ঴য়। তমভন- তকান ঳ংখোরক % রচহ্ন, দ঱রভক রচহ্ন, ভুদ্রা ফা 
Currency আতোরদয জনে Number িোফ ফেফ঴ায কযা ঴য়।  

1) অ঩নায ততযী কযা ডািারফজরি তথরক E1 তথরক E7 ঩মকন্ত র঳ররক্ট করুন; 
2) তভনু তথরক Format এ রিক করুন; 

 
3) Cells..... এ রিক করুন; Format Cells..... ডায়ারগ ফে অ঳রফ- 
4) Number িোফ র঳ররক্ট করুন; (মরদ র঳ররক্ট কযা না থারক) 
5) Category ফে তথরক Number র঳ররক্ট করুন। Decimal Places ঄঩঱রন 2 র঳ররক্ট থাকরফ ঄থকাৎ 

দ঱রভরকয ঩য দুআঘয অ঳রফ। দ঱রভরকয ঩য দুআ ঳ংখোয তফ঱ী চাআরর ত঳আ ঩রযভান ঳ংখো িাআ঩ 
করুন; ঄থফা অ঩/ডাউন এোরযা-এ রিক করয র঳ররক্ট করুন; 

6) ত঱রল OK কভান্ড করুন। অ঩নায তরখা E1 তথরক E7 ঩মকন্ত ডািাগুরর দ঱রভক এফং ঴াজারযয ঩য 
কভা঳঴ রদর঱ত ঴রফ।   
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Worksheet -এ ঄ফরিত রফরবন্ন ঄রথকয ঩রযভারনয অরগ Tk., Rs, $ আতোরদ ঳াআন তদ঑য়ায দযকায ঴রর 
রনরচয Step গুররা ঄নু঳যণ করুন-  

1) ডািারফরজয E1 তথরক E7 ঩মকন্ত ব্লক করুন; 
2) অরগয ভত তভনুফায তথরক Format ঴রয় Cells -এ রিক করুন; ডায়ারগ ফে অ঳রফ- 
3) Number িোফ র঳ররক্ট করুন (মরদ র঳ররক্ট করয না থারক);  

4) Category ফে তথরক Currency র঳ররক্ট করুন। ডায়ারগ ফে চরর অ঳রফ- 
5) Symbol ঄঩঱রন রডপর ভুদ্রা $ র঳ররক্ট থাকরফ। ড্র঩-ডাউন রিক করয, ররষ্ট তথরক আোভরতা ভুদ্রা 

ত঳রিং করুন; 
6) দ঱রভরকয ঩য ঳ংখো চাআরর Decimal Places ঄঩঱রন তা রনধকাযণ করুন; 
7) ত঱রল OK করুন। অ঩নায র঳ররক্ট কযা ঄ংর঱য ডািায ঳ারথ ভুদ্রা রচহ্ন থাকরফ।  
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 : Border ঳ংরমাজন কযা

Sheet -এয গ্রীড (ঘয) গুররা ররন্ট কযরর অর঳ না। এজনে রফরবন্ন ধযরণয ফডকায ঳ংরমাজন কযরত ঴য়। 
রনরোক্ত ঩দ্ধরত ঄নু঳যণ করুন-  

1) A1 ত঳র তথরক E7 ত঳র ঩মকন্ত র঳ররক্ট করুন। (঄থফা আোভত তিে ব্লক করয রনন)  
2) Format এ রিক করুন;  
3) Cells.... এ রিক করুন; ডায়ারগ ফে অ঳রফ-  

4) Border িোফ রিক করুন;  
5) Line স্টাআর রিক করয Presets স্টাআরর  
Outline, Inside রিক করয রনন; 

6) OK রিক করুন। র঳ররক্ট কযা ঄ংর঱ ফডকায ঳ংমুক্ত ঴রফ।  
এছাড়া আোভরতা ত঳র ফা Range (করয়করি ত঳ররক একরে Range ফরর) র঳ররক্ট করয িুরফায তথরক঑ ফডকায 
তদ঑য়া মায় ফা ফডকায তদ঑য়া ঄ংর঱য ফডকায তুরর তপরা মায়। আোভরতা ত঳র র঳ররক্ট করয রনরচয রনরদক঱ভত 
঄নু঱ীরন করয তদখুন।  

িুরফায তথরক Border িুররয ড্র঩-ডাউরন ঄থকাৎ রনেভুখী তীরয রিক করয র঳ররক্ট করুন। ফডকারযয ঄নোনে 
঄঩঱ন অ঳রফ।  
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Page Setup কযা : 

পাআরর ডািা এরি কযায ঩ূরফকআ, ঄ন্তত ররন্ট কযায ঩ূরফক ঄ফ঱েআ Page Setup রিক করয রনরত ঴রফ। ঩রয 
Page Setup ঩রযফতকন কযরর রফরবন্ন ধযরণয ঳ভ঳ো তদখা তদয়।  

রফরবন্ন ভার঩য কাগরজয ঑য়াকক঱ীিরক ররন্ট কযা মায়। ফাজারয রচররত কাগরজয ঳াআজ ঴রে Letter = 8.511 
আরি ফা A4 = 8.2711.69 আরি ফা Legal = 8.514 আরি। এছাড়া রনরজয ররয়াজনীয় ত঩঩ায ঳াআজ ত঳রিং 
করয তন঑য়া মায়।  

1) File এ রিক করুন; 
2) Page Setup এ রিক করুন; ডায়ারগ ফে অ঳রফ- 
3) Page িোফ র঳ররক্ট অরছ রকনা রনরিত ঴রয় রনন; 

4) Paper Size ঄঩঱রন ডানরদরকয ড্র঩-ডাউরন রিক করয অ঩নায ঩ছরেয ঳াআরজ রিক করুন; 
5) অ঩নায ররয়াজরন Portrait ঄থফা Landscape স্টাআর এ রিক করয র঳ররক্ট করয রনন;  
6) ঳ফর঱রল OK রদন। 
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ভারজকন ঴রে কাগরজ তকান ডকুরভন্ট ররন্ট কযায ঩য উ঩রয, রনরচ, ডারন, ফারভ কতিুকু পাাঁকা জায়গা থাকরফ 
ত঳রি। ভারজকন ত঳ি কযরত ঴রর রনে঩দ্ধরত ঄নু঳যণ করুন- 

করয তন঑য়া মায়।  

1) File এ রিক করুন; 
2) Page Setup এ রিক করুন; ডায়ারগ ফে অ঳রফ- 
3) Margin র঳ররক্ট করুন;  

4) উ঩রয, রনরচ, ডারন, ফারভ কতিুকু পাাঁকা ফা আরি ঴রফ তা ত঳ি করয রনন;  
5) OK এ রিক করুন। 

চািক ফা তরখরচে কথারিয ঳ারথ অভযা ঳ফাআ ঩রযরচত। বূরগারর রফরবন্ন তদর঱য ফা একআ তদর঱য রফরবন্ন তজরা ফা 
঱঴যগুররায জন঳ংখো, অফ঴া঑য়ায তাযতভে, জন্ম-ভৃতুে঴ায আতো গারণরতক তথে঳ভূ঴ মা ঄রনক ঳ংখোয় তা 
গ্রারপয ভাধেরভ ঳঴জবারফ ঩রযরফ঱ন কযা তদরখরছ। এবারফ জরির ঳ংখোত্মক রফফৃরতরত রচরেয ভাধেরভ 
঳঴জবারফ ঩রযফরফ঱ন কযাআ ঴রে গ্রাপ ফা তরখরচে। গ্রারপয তভৌররক রদক ঴রে, তম ঳ভস্ত ঳ংখো যার঱রক 
গ্রারপয উ঩াদান র঴র঳রফ রফরফচনা কযা ঴রফ তারদয তুরনাভূরক ঩মকাররাচনারক রচরেয ভাধেরভ ফর঴ঃরকা঱ কযা। 
তাআ ঴ারত-কররভ চািক ততযী কযা করিন ঑ ঳ভয় ঳ার঩ক্ষ। চািক ফা গ্রাপ রফদোয় দক্ষ Pictographer ফা তরখরচে 
ততযীকাযী ফেরক্ত একভাে চািক ততযী করয থারকন। রকন্তু চািক তভনু ফেফ঴ায করয অ঩রন রনরজআ রফরবন্ন ধযরণয 
চািক রনরভরলআ রনবুকরবারফ ততযী কযরত ঩াযরফন। তায অরগ চরুন অভযা গ্রাপ ঳ম্পরকক অভযা অরযা ঩রযরচত 
঴আ।  
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তকান রযর঩ারিকয ডািা রদ঱করনয জনে ঳ফরচরয় ঳঴জ উ঩ায় ঴ররা Chart ফা Graph| Excel-G রফরবন্নবারফ চািক 
এয ভাধেরভ ডািারক তুরর ধযা মায় এফং চািকরক রফরবন্ন স্টাআরর ঳াজারনা মায়। Excel এয Chart Wizard 
তথরক অ঩নায আোভত Chart ঩ছে করয উ঩িা঩ন কযরত ঩াযরফন।  

঳঴রজ চািক ঴রে অ঩নায ডািারক তরখারচে ফা ছরফয ভাধেরভ রকা঱ কযা। 

ধরুন, ঳ারিয, যাকা ঑ ফর঱য রতনজরন রভরর একরি তকক িয় কযর। ঳ারিয রদরয় ৭.০০ িাকা, যাকা ৫.০০ 
িাকা এফং ফর঱য রদরয় ৪.০০ িাকা। এখন তাযা তকরকয তক কত ঄ং঱ ঩ারফ তা রচরেয ভাধেরভ রনরেয নোয় 
রকা঱ কযা মায়।  

 

 

 

 

 

 

 

 

 

তাযা রতনজরন রভরর তভাি রদরয়রছ ১৬.০০ িাকা। তাআ ঳ারিয ঩ারফ ৭/১৬ ঄ং঱, যাকা ঩ারফ ৫/১৬ এফং ফর঱য 
঩ারফ ৪/১৬ ফা ১/৪ ঄ং঱। ঳মূ্পণক তককিা ১০০% ঴রর ঳ারিয ঩ারফ ১০০ এয ৭/১৬ = ১৭৫/৪ = ৪৪%, যাকা 
঩ারফ ১০০ এয ৫/১৬=৩১% এফং ফর঱য ঩ারফ ১০০ এয ৪/১৬=২৫%। 

উ঩রয তম রচরেয ভাধেরভ এগুররা রকা঱ কযা ঴রয়রছ তা঑ ঴রে চািক ফা তরখরচে। (এিা ঴রে ফৃি গ্রাপ)। 
এবারফ ঳ংখো (৭, ৫, ৪) রচরেয ভাধেরভ রকা঱ কযরর তম তকউ তা তদরখআ চট্  করয ফুঝরত ঩াযরফ তক রক 
঩রযভান ঩ারফ।  

Sabbir 
44% 
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31% 

Rakha 
25% 
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Bashir

Rakha
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ডািার঱ি তথরক ডািা রনরয় চািক ফা রচরেয ভাধেরভ উ঩িা঩ন কযায জনে রনরেয ঩দরক্ষ঩ রনরত ঴রফ : 

1.   ডািার঱ি (঑য়াককর঱ি পাআররক) ঩দকায় ঳চর কযরত ঴রফ।  
2. ডািা তযঞ্জ রনফকাচন কযরত ঴রফ।  
3. Insert>Chart রনরদক঱ রদরয় Chart Type রনফকাচন কযরত ঴রফ  
4. Next ফািরন রিক করয ডািা তযঞ্জ রনফকাচন কযা না থাকরর ডািা তযঞ্জ রক ঴রফ তা Data Range ফরে 

রররখ রদরত ঴রফ এফং ডািা র঳রযজ রক তযা রবরিক না-রক করাভ রবরিক ঴রফ তা Series in এয 
Column ফা Row রনফকাচন করয রনধকাযণ কযরত ঴রফ।  

5. ডািা তযঞ্জ এয তম ডািা঳ভূ঴রক ডািা র঳রযজ র঴র঳রফ তন঑য়া ঴রয়রছ তা তথরক তকান ডািা র঳রযজ ফাদ 
রদরত চাআরর ফাদ রদরত ঴রফ ঄থফা ঳ংরমাজন কযরত চাআরর ঳ংরমাজন কযরত ঴রফ।  

6. অফায Next ফািরন রিক করয Chart Wizard-Step 3 of 4-Chart Options ডায়ারগ ফরেয 
঄঩঱ন রনফকাচন করয ররয়াজন ঄নু঳ারয চারিকয Titles, Axis, Gridlines, Legend, Data Labels, 
Data Table আতোরদ রনধকাযণ করয রদরত ঴রফ।  

7. Next ফািরন রিক করয চািকরি তকাথায় ঴রফ তা Chart Wizard Step 4 of 4 Chart Location 
ডায়ারগ ফরে রনধকাযণ করয Finish ফািরন রিক কযরর চািক ততযী ঴রফ।  

8. ররয়াজনীয় ঳ংরয়াধন করয চািকরি Save কযরত ঴রফ।  

গ্রাপ ততযী কযরত ঴রর রনরোক্ত ঩দ্ধরত ঄নু঳যণ করুন- 

1) হুফহু রনরচয ভত ডািা রদরয় Worksheet রি ঩ূণক করুন; (A1 তথরক D4 ঩মকন্ত ব্লক করুন) 
2) তভনু তথরক Insert এ রিক করুন; 
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3) Chart এ রিক করুন; ডায়ারগ ফে অ঳রফ- 

4) রনরজয ভত স্টাআর ঩ছে করয রনন;  
5) Next ফািরন রিক করুন। ঩দকায় অ঳রফ- 
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অফায Next ফািরন রিক করুন; ঩দকায় অ঳রফ- 

 

6) অফায Next ফািরন রিক করুন। ঩দকায় অ঳রফ-  

7) Finish ফািরন রিক করুন। ঩দকায় রনরেয চািরি ততযী ঴রফ।  

Note: Fill Color এ রিক করয অ঩নায ররয়াজরন গ্রাপ এয রপল্ড কারায উ঩য রিক করয ঩ছরেয যং 
঩রযফতকন করয রনরত ঩ারযন। 
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এখন অভযা রকছু গারণরতক র঴঳াফ কযরফা। তমভন- তমাগপর, রফরয়াগপর, গুণপর, বাগপর, গড় রনণকয়, রফর 
ততযী কযা, Salary Sheet ততযী আতোরদ কযা মায়।  

তমাগপর তফয কযা : 
তমাগপর তফয কযা জনে রনরোক্ত ঩দ্ধরত ঄নু঳যণ করুন-  

1) এবারফ রকছু ঳ংখো িাআ঩ করুন; মথা- 

2) তায঩য ঳ফগুররা ব্লক করয রনন; ঳ফায রনরচ অরযা ঄রতরযক্ত একরি ঘয ব্লক করয রনন; তায঩য- 
3) স্টান্ডাডক ফায- এ       এ    (AutoSum) রচরহ্ন রিক কযরর তযজাল্ট তফয ঴রফ।  

঄থফা, তম ঘরয উিয ঴রফ ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। ধরুন- B7 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায 
যাখুন। তায঩য ঳ূে ররয়াগ করুন। মথা- =b1+b2+b3+b4+b5+b6 রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় মারফ।  

঄থফা, ধরুন- B7 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। তায঩য ঳ূে ররয়াগ করুন। মথা- 
=sum(b1..b6) রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় মারফ। 

রফরয়াগপর তফয কযা : 
রফরয়াগপর তফয কযায জনে রনে঩দ্ধরত ঄নু঳যণ কযন-  

1) এবারফ ঳ংখো িাআ঩ করুন; মথা- 
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2) তম ঘরয উিয ঴রফ ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। ধরুন- B3 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায 
যাখুন।  

3) তায঩য ঳ূে ররয়াগ করুন। মথা- =b1-b2 রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় মারফ।  

গুণপর তফয কযা : 
গুনপর তফয কযরত ঴রর রনে ঩দ্ধরত ঄নু঳যণ করুন- 

1) এবারফ ঳ংখো িাআ঩ করুন; মথা- 

2) তম ঘরয উিয ঴রফ ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। ধরুন- B3 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায 
যাখুন।  

3) তায঩য ঳ূে ররয়াগ করুন। মথা- =b1*b2 রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় মারফ।  

বাগপর তফয কযা : 
বাগপর তফয কযরত ঴রর রনে ঩দ্ধরত ঄নু঳যণ করুন- 

1) এবারফ ঳ংখো িাআ঩ করুন; মথা- 
 

 

 

 

 

 

2) তম ঘরয উিয ঴রফ ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। ধরুন- B3 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায 
যাখুন।  

তায঩য ঳ূে ররয়াগ করুন। মথা- =b1/b2 রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় মারফ। 
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গড় তফয কযা জনে রনরোক্ত ঩দ্ধরত ঄নু঳যণ করুন-  

1) এবারফ রকছু ঳ংখো িাআ঩ করুন; মথা- 

2) তম ঘরয উিয ঴রফ ত঳ ঘরয ত঳র঩রয়ন্টায যাখুন। ধরুন- B10 ঘরয উিয ঴রফ; তা঴রর ত঳ ঘরয ত঳র঩রয়ন্টায 
যাখুন। তায঩য ঳ূে ররয়াগ করুন। মথা- =average(b1..b10) রররখ Enter এ চা঩ রদন। উিয তফয ঴রয় 
মারফ। 
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ভরন করয, তকান তকাম্পারনয ঳াযারদরনয ঄রনক রকছু রফিয় ঴রয়রছ। এখন জানা দযকায তকাম্পানী ঳াযারদরনয 
তভাি কত িাকায ঩রযভান ভার রফিয় ঴ররা। তা঴রর ঳াযারদরনয রফিরয়য রফর ততযী কযরত ঴রফ। এরেরর 
঄তেন্ত ঳঴জ ঩দ্ধরত তা ঳ম্পন্ন কযা মায়। তকান রফর ততযী কযরত ঴রর রনে ঩দ্ধরত ঄নু঳যণ করুন-  

1) হুফহু রনে ঩দ্ধরত িাআ঩ করুন; মথা- 
 

 

2) এবারফ ততরয কযা ঴র। তায঩য তম ঘরয উিয ঴রফ ত঳খারন ত঳র঩রয়ন্টয যাখুন; তমভন অ঩রন E4 এ 
উিয রদরত চান তা঴রর ঐ ঘরয ঩রয়ন্টায যাখুন;  

3) এখন ঳ূে িাআ঩ করুন; মথা- =C4*D4 রররখ Enter রদন (এখারন C4 ফররত রফিরয়য ঩রযভান এফং D4 
ফররত ররতরি রফিরয়য ভূরেরক ঝুঝারফ); উিয চরর অ঳রফ।  

4) এখন কর঩ করয রনরচয রদরক িানুন; ফাকীগুররারত঑ উিয চরর অ঳রফ।  
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এখন অভযা একরি Salary Sheet ততযী কযরফা। ররতেরকয একরি Basic তফতন থাকরফ। ফাড়ীবাড়া ফা 
House Rent (H.R.) ঴রফ Basic এয 50%, রচরকৎ঳া বাতা ফা Medical Allowance (M.A.) ঴রফ Basic এয 
20%, মাতায়াত ফা Travel Allowance (T.A.) ঴রফ Basic এয 15% এফং ঄নোনে খযচ (Others) ফাফদ 
Basic এয 5% ররতেরক ঩ারফ। Basic, H.R., M.A., T.A. এফং Others তমাগ করয Gross Salary তফয 
কযরত ঴রফ।  

এয঩য Income Tax কািা মারফ Basic এয উ঩য রবরি করয। এখারন রফর঳ক কতকন ঴রফ 3%| Provident 
Fund (P.F.) কািা মারফ Basic এয 10%| এবারফ Provident Fund এফং Income Tax তমাগপর তফয করয 
Total Payable (Total Pay) তফয কযরত ঴রফ। এয঩য Gross Salary তথরক Total Pay ফাদ রদররআ Net 
Pay ঩া঑য়া মারফ। চরুন Salary Sheet রি ততযী কযা মাক। 

১. হুফহু রনরজয ভত একরি Worksheet ততযী করুন। 
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২. এখন D2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*50% এফং Enter রদন। Basic এয 50% ফাড়ীবাড়া 
঩া঑য়া মারফ।  

৩.  E2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*20% এফং Enter রদন। Basic এয 20% তভরডরকর এরাউন্স 
঩া঑য়া মারফ।  

৪.  F2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*15% এফং Ener রদন। Basic এয 15% মাতায়াত খযচ ঩া঑য়া 
মারফ।  

৫.  G2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*5% এফং Enter রদন। Basic এয 5% ঄নোনে খযচ ঩া঑য়া 
মারফ। এখনআ এআ রাপ্ত পরাপর তমাগ করয Total কযরফা।  

৬.  H2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =sum(D2..G2) এফং Enter রদন। এখন Basic তফতরনয ঳ারথ 
঄নোনে রা঩ে তমাগ করয Gross Salary তফয কযরফা।  

৭.  I2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2+H2 এফং Enter রদন। I2 ত঳রর Gross Salary ঩া঑য়া মারফ। 
এখন Income Tax তফয কযরত ঴রফ।  

৮.  J2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*3% এফং Enter রদন। J2 ত঳রর Income Tax ঩া঑য়া মারফ।  

৯.  K2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =C2*10% এফং Enter রদন। Provident Fund ঩া঑য়া মারফ। 
এখন Income Tax ঑ Provident Fund তমাগ করয Total Payable ভান তফয কযরফা।  

১০. L2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =Sum(J2..K2) এফং Enter রদন।  

১১. M2 ত঳রর ঩রয়ন্টায তযরখ িাআ঩ করুন =I2-L2 এফং Enter রদন। ফো঳ Net Salary ঩া঑য়া মারফ।  

১২. এখন কর঩ পভূকরায এয ভাধেরভ কর঩ করয রনন। তায঩য ঳ুেয করয রনরজয ভত ঳ারজরয় রনন। 
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আপনি যযহ঵তু এই য঱খা পড়হেি , তাই আনম ধহর নিনি যয আপনি কনিউটার ও ইন্টারহিট বযব঵াহর অনভজ্ঞ ,কাহেই কনিউটাহরর প্রহয়ােিীয় 
নব঳য় গুহ঱া ঴িহকে  ভাহ঱া খারাপ নবহবচিা করারা ক্ষমতা অবশ্যই আহে … 
তাই আপিাহের কাহে একান্ত অনুহরাধ “ আপিারা ঴ামান্য একটু ঴ময় বযয় কহর ,শুধু এক বার নিহচর ন঱িংহক নিক কহর এই DVD গুহ঱ার মহধয 
অবনিত বই ও ঴ফটওয়যার এর িাম ঴মূহ঵র উপর যচাখ বুন঱হয় নিি।”তা঵হ঱ই বুহে যহবি যকি এই DVD গুহ঱া আপিার কাহ঱কলহি রাখা 
েরকার!আপিার আেহকর এই বযয়কৃত ঴ামান্য ঴ময়  ভনবষ্যহত আপিার অহিক কষ্ট ঱াঘব করহব ও আপিার অহিহক ঴ময় বাাঁনচহয় নেহব। নবশ্বা঴ 
করুি আর িাই করুিঃ- “নবনভন্ন কযাটাগনরর এই DVD গুহ঱ার মহধয যেওয়া বািং঱া ও ইিংন঱ল বই , ঴ফটওয়যার ও নটউহটানরয়া঱ এর কাহ঱কলি 
যেহখ আপনি ঵তবাক ঵হয় যাহবি !”  
আপনি যনে বতেমাহি কনিউটার বযব঵ার কহরি ও ভনবষ্যহতও কনিউটার ঴াহে যুক্ত োকহবি তা঵হ঱ এই নিনভনি গুহ঱া আপিার অবশ্যই আপিার 
কাহ঱কলহি রাখা েরকার........ কারিঃ  
 এই নিনভনি গুহ঱া যকাি যোকাহি পাহবি িা আর ইন্টারহিহটও এহতা ইিরটযান্ট কাহ঱কলি এক঴াহে পাহবি বহ঱ মহি ঵য় িা।তাোড়া এত বড় 
঴াইহের ফাই঱ যিট যেহক িামাহিা খুবই কষ্ট঴াধয ও ঴ময়঴াহপক্ষ বযাপার।এোড়া আপনি যযই ফাই঱টা িামাহবি তা ফু঱ ভা঴েি িাও ঵হত পাহর .. 
 
 এই নিনভনি গুহ঱া আপিার কাহ঱কলহি োকহ঱ আপিাহক আর যকাি কনিউটার নবহল঳জ্ঞহের কাহে নগহয় টাকার নবনিমহয় বা বনু্ধহের খানতহর 
“ভাই একটু য঵ল্প করুি” বহ঱ অন্যহক নবরক্ত করা ঱াগহব িা ... ও  নিহেহকও ঵য়রানি ঵হত ঵হব িা ।  
 

 এই নিনভনি গুহ঱ার মহধয অবনিত আমার করা ৩০০ টা বািং঱া ই-বুক (pdf ) ও যোট ঴াইহের প্রহয়ােিীয় ঴ফটওয়যার আপিাহের েন্য 
নবিামূহ঱য আমার ঴াইহট যলয়ার কহর নেহয়নে । নকন্তু প্রহয়ােিীয় বড় ঴াইহের বই, নটহটানরয়া঱ ও ফু঱ ভা঴েি ঴ফটওয়যার  গুহ঱া যলয়ার ঴াইট 
গুহ঱ার ঴ীমাবদ্ধতা ও ইন্টারহিহটর যলা আপহ঱াি গনতর েন্য যলয়ার করহত পার঱াম িা । তাোড়া এই বড় ফাই঱ গুহ঱া িাউিহ঱াি করহত যগহ঱ 
আপিার ইন্টারহিট পযাহকহের    ক নেনব খরচ করহত ঵হব ... যযখাহি ১ নেনব পযাহকে েন্য  ঴বেনিম্ন ৩৫০ টাকা যতা খরচ ঵হব , এর ঴াহে 
঴ময় ও ইন্টারহিট গনতরও একটা বযাপার আহে। এই ঴ব নব঳য় নচন্তা কহর আপিাহের েন্য এই নিনভনি পযাহকে চা঱ু কহরনে ... 
 

যমাট কো আপিাহের কনিউটাহরর নবনভন্ন ঴মস্যার নচরিায়ী ঴মাধাি ও কনিউটাহরর েন্য প্রহয়ােিীয় ঴ব বই, ঴ফটওয়যার ও নটউহটানরয়া঱ এর 
঴ানবেক ঴াহপাটে নেহত আমার খুব কাযেকর একটা উহেযাগ ঵হি এই নিনভনি পযাহকে গুহ঱া ...  

 
এই                ক                       ক       ... শুধু একবার যচাখ বু঱াি    

  http://tanbircox.blogspot.com/2013/07/My-DVD-Collection-4-U.html  
 

[যমাট দুইটা নিনভনি , ঴াইে ৯ নেনব] আপিার নলক্ষােীবহির েন্য প্রহয়ােিীয় ঴ব বািং঱া বই ও ঴ফটওয়যার   
  http://tanbircox.blogspot.com/2013/04/Complete-Solution-of-your-Education.html  
 

 [যমাট নতিটা নিনভনি, ঴াইে ১৩.৫ নেনব]Genuine Windows XP Service Pack 3 , 

Windows 7 -64 & 32 bit & Driver Pack Solution 13 এর ঴াহে রহয়হে উইহন্িাহের েন্য প্রহয়ােিীয় বািং঱া বই ও ঴ফটওয়যার  
  http://tanbircox.blogspot.com/2013/07/All-Genuine-Windows-Collection.html  
 

  All MS Office, documents ,pdf reader & Pdf edit Software  এবং প্রহয়ােিীয় ঴ব বািং঱া বই।  
যয যকাি ধরহির িকুহমন্ট এনিট , কিভাটে ও নিোইি করার েন্য এই নিনভনি নট যহেষ্ট , এই নিনভনি যপহ঱ অনফ঴ ও িকুহমন্ট ঴িনকেত যয 

যকাি কাহে অ঴াধয বহ঱ নকেু োকহব িা... আপিার অনফন঴য়া঱ কাহের েন্য প্রহয়ােিীয় ঴ফটওয়যাহরর ঴িূর্ে ও নচরিায়ী ঴মাধাি... 
  http://tanbircox.blogspot.com/2013/07/office-documents-soft-dvd.html  
 

: [ ঵হয় যাি য঴রা নিোইিার ] নিোইি ,গ্রানফক্স ও েনব এনিট ঴িনকেত প্রহয়ােিীয় ঴ব 
বািং঱া ও ইিংন঱ল ই-বুক ,নটউহটানরয়া঱ ও ফু঱ ভা঴েি ঴ফটওয়যার।      ও এ          ই     ও       এ    ই   আ   ক  ই           

http://tanbircox.blogspot.com/2013/07/All-Design-and-Graphics-Software.html  
 

 প্রহয়ােিীয় ঴ব বািং঱া ও ইিংন঱ল ই-বুক ,নটউহটানরয়া঱ ও ফু঱ ভা঴েি ঴ফটওয়যার। 
   http://tanbircox.blogspot.com/2013/07/All-Internet-And-Web-programming-Software.html  

 A2Z Audio & Video player , Edito & converter . CD, DVD edit 
ও উইহন্িাে যক সুন্দর যেখাহিার েন্য প্রহয়ােিীয় ঴ব ফু঱ ভা঴েি ঴ফটওয়যার। 
  http://tanbircox.blogspot.com/2013/07/All-Multimedia-And-Windows-Style-Software.html  
 

  http://tanbircox.blogspot.com/2013/07/mobile-software-hardware-dvd-5000.html  
 

   http://tanbircox.blogspot.com/2013/07/A2Z-Bangla-ebooks-Collection.html  
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